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Overview 
Respondus is third party software that allows instructors to upload tests into Desire2Learn courses form a 
text file, rich text file or Word document.  Users can also print or save hard copy tests through Respondus. 

Objectives 

� Download and install Respondus 
� Create a test or self-assessment within Respondus 
� Properly format assessment questions for Respondus 
� Import assessment questions into Respondus 
� Create Desire2Learn availability settings within Respondus 
� Preview and modify your test in Respondus 
� Publish your test or survey to your course(s) in Desire2Learn 

What is Respondus? 

Respondus allows you to create exams in a standard word processing program, which can then be quickly and 
easily imported into Desire2Learn. Instructors may also choose test settings that will transfer into D2L. 

Downloading Respondus to your Computer 

The Office of Academic Technology and eLearning and Online Education has made it possible for all ETSU 
faculty to download and use the Respondus software for free. The software and instructions for downloading 
are available at: http://www.etsu.edu/academicaffairs/elearning/ats/respondus/. You will have to 
provide your ETSU username and password to access the information. Your username should be preceded 
by: etsu\ 

Follow the installation directions listed on the web page.  Please contact the Office of eLearning if you have 
questions or problems downloading the software.  
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Update your version of Respondus 
Respondus releases updates from time to time that increase the functionality, usability and compatibility of 
Respondus with D2L. Respondus will prompt you to check for updates if it has been a while since you logged 
in to Respondus or updated the software. You can also manually check for updates periodically. 

1. Login to Respondus and choose Help > Check for Update.

2. Select Get Update.  You may need to wait a few minutes for the update to download.
3. Click OK.  The program will close.  When you re-open Respondus you should have the most recent

version.  If you want to be sure, select Help > About Respondus.  The most current version of
Respondus is 4.0.1.

4. Make sure you select Desire2Learn for your personality.

Getting Started 

When you first log in to Respondus, you will see a screen similar to the one shown.  There are several options 
for accessing and creating exams, including Create a new Respondus file (or exam), the Exam Wizard, and 
Importing Questions from a text file.   

Changing the Default Point Value 
The default point value for questions in Respondus is 1.0.  You can easily change the default value by going 
to File > Preferences > Edit & Publish.  You may change the default value each time you create an exam 
or for blocks of questions.  The default point value will apply to questions imported from a text file.  You 
may also change the point value for individual questions in the Edit screen. 
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Open 
Use Open to access an exam that has already been created.  Notice that Respondus provides some sample 
exams that you can use for practice.   

1. Click on the file name to highlight the file you wish to edit or view.
� Click Open to select the file to view. 
� The General Information button will list information such as the number of questions, the 

date the test was created, etc. 
� The Item List button will show a listing of the questions themselves (see example 

below.)  You can preview a particular question by clicking on the blue underlined title. 
2. You can use the New Folder button to create a new folder in which to organize your exams.

Create 
Use the Create feature to create a file by adding individual questions. 

1. Provide a name and description of the file to be created.  Click OK.
2. The Edit tab will open.  Select the type of question you wish to create by clicking on the link on

the left of the page.  The question creation screen will change based on the type of question that is
selected.



4 

3. You can create a Title to transfer into D2L or Respondus will enter the first 20 characters of the
question in the Title field by default.

4. Enter the question text.  You may use the Edit functions (shown below) to add Bold, Italics,
Underline, subscript, superscript, an equation, or attach files.

5. Depending on the type of question you are creating, enter the possible answers, and designate

the correct answer in the answer space.
6. Click the General Feedback button to provide feedback for correct or incorrect responses.
7. Change the point value, if necessary.
8. Preview the question to see what students will see when they take the exam (this is especially

recommended if you are incorporating files or hyperlinks.)
9. Choose whether to append the question to the end of the current list, insert the question into pre-

existing questions, or clear the form and begin again.

The Exam Wizard 

The Exam Wizard allows you to create an exam using existing exams or a publisher test bank.  Questions may 
be randomly selected or specifically chosen based on the question text.  Point values can be assigned across 
the entire question type. 

1. Select Exam Wizard from the Start menu.
2. Select the first choice Create a New Exam and then Copy Questions…  Click Next.

3. Provide a name and description for your exam.
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4. Highlight the exams to include as options for questions by clicking on the name of the exam.  Click
Select to add the names to the available box.  Click Next.

5. Choose the source file (the exam containing the questions you wish to include.)
6. Choose either automatic or manual selection.  If you choose automatic selection, choose the

number of each type of question you wish to use.  Manual selection will let you choose individual
questions.  Click Add to End of List to add the questions to the new exam.  Click Next after
selecting the questions.

7. You may then choose to create the settings for publishing the file, direct publishing of the file,
etc.  Click Finish.

Respondus Test Questions 

Respondus makes it easy to search their publisher network to see if the text you are using already has test 
banks available for download. 

Navigate to: http://www.respondus.com/testbank/search.php and enter the requested information. 
If a test bank is available, you will be able to upload that directly into Respondus. 

Import Questions 

The Import Questions option allows you to import a text (.txt), rich-text (.rtf), MS Word (.doc), or 
tab/comma delimited (.csv) file containing the questions and answers for the exam.  This option allows you 
to quickly create an exam using word processing software, eliminating the need to manually enter individual 
questions.  You can also modify existing quizzes or exams by changing the formatting to adhere to the 
Respondus “standard format.” 

The first step is to create your file containing the questions and answers.  You must follow the standard 
format for each question type or Respondus will not be able to distinguish the questions and correct answers. 

Examples of acceptable standard formatting follow. 

Multiple Choice Questions 

Begin by entering the question number.  The question number must be followed by either a period or a 
closed parenthesis {1. or 1)}.  You must enter a space following either 1. or 1).  Enter the possible 
answers after the question.  Again, the answer must be in one of the following formats {a. or a)}.  Indicate 
the correct answer by placing an asterisk {*} on the line before the correct answer. 

Multiple Choice Question Example 

1. Who is the wealthiest man in America?
a. Donald Duck
b. Bugs Bunny
c. Mickey Mouse*d. Bill Gates

*d. Bill Gates 
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You may choose to add correct and incorrect feedback when entering the question. 

Multiple Choice Question Example (with Optional feedback)  

1. Who is the wealthiest man in America?

~ Yes. Bill Gates is currently the wealthiest man in America. 

@ No. Cartoon characters are not typically good investors. 

a. Donald Duck
b. Bugs Bunny
c. Mickey Mouse

*d. Bill Gates 

True/False Questions 

Begin by entering the question number.  The question number must be followed by either a period or a 
closed parenthesis {1. or 1)}.  You must enter a space following either 1. or 1).  Enter the possible answers 
after the question.  True must be listed before false, if not, Respondus will view this as a multiple 

choice question.  Again, the answer must be in one of the following formats {a. or a)}.  Indicate the correct 
answer by placing an asterisk {*} on the line before the correct answer. 

True/False Question Example 

2. The Olympic Games take place every four years.

*a. T 
b. F

Long Answer or Essay Questions 

Begin by entering Type: E.  Enter the question number, followed by the text of the question.  You may 
enter an answer if you choose.  This will appear as feedback for the student after they have submitted their 
own answer.  Note:  The terminology used for this question type in D2L is Long Answer. 

Long Answer Question Example 

Type: E 

3. Compare and contrast the comic strip characters Bucky Katt and Garfield the cat.
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Fill in the Blank or Short Answer Questions 

Begin by entering Type: S.  Enter the question number, followed by the text of the question.  You may 
enter variations of the answer following the answer letter.  You do not need to indicate the correct answer 
with an asterisk, as all answers entered here will be a correct answer.  Note:  The terminology used for this question 
type in D2L is Fill in the Blank. 

Fill in the Blank Question Example 

Type: S 

4. ____________ is the best University in the eastern Tennessee region.

a. ETSU
b. East Tennessee State University
c. East Tenn. State Univ.

Matching Questions 

Begin by entering Type: MT.  Then enter the question number, followed by the text of the 
question.  Enter the item separated from its correct match by an equal sign {=}.  It does not matter if you 
include a space before or after the equal sign; however, only the equal sign may be used with a matching 

question. 

Matching Question Example 

Type: MT 

5. Match each comic strip character with its appropriate sidekick.

a. Kit = Carlyle
b. Snoopy = Woodstock
c. Beetle Bailey = Sarge
d. Garfield = Odie
e. Mickey Mouse = Donald Duck

Multiple Response Questions  

Begin by entering Type: MR.  Enter the question number, followed by the text of the question.  Enter the 
possible choices preceded by a letter {a. or a}.  Indicate the correct answers by typing an asterisk {*} at the 
beginning of each answer. 
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Multiple Response Questions 

Type: MR 

6. Which of the following are “reality” shows?

*a. Survivor 
b. World Championship Wrestling
c. Friends

*d. The Apprentice 
e. Jeopardy

Note about entering answers: 

You may also choose to enter all of your answers at the bottom of the page 
following the questions.  If you choose this method, type in all questions in the 
required format and follow that with the word Answers: and the corresponding 
answer for each question.  See the following example. 

Example of all Answers at the bottom of the file: 
Answers: 
1. D
2. B
4. A, B, C

Importing Images with Questions in a Word Document 

It is possible to include images with questions if you are using Word documents.  You only have to include 
the image in the Word file and the image will import automatically. 

Multiple Choice Question with Image Example – Microsoft Word  

7. Who painted this controversial masterpiece?

a. Pablo Picasso
*b. John Singer Sargent 
c. Paul Cezanne
d. Edvard Munch
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Importing Images with Questions in a Text File 

It is also possible to include images with questions if you are using text files.  You must refer to the filename 
in the following manner: {[img: “filename.jpg”]}.  The image to be placed in the question must be in .jpg, 
.jpeg, or .gif format.  All images to be included must be contained in a single folder.  This folder will be 
uploaded to Respondus when Importing the file.  In the following example, a .jpg image was added to a 
multiple choice question. 

Multiple Choice Question with Image Example – Text file 

7. Who painted this controversial masterpiece? [img: “madamex.jpg”]

a. Pablo Picasso
*b. John Singer Sargent 
c. Paul Cezanne
d. Edvard Munch

Import HTML with Questions 

You may also include HTML coding in your questions.  You must place the HTML code within tags.  The 
following example includes a link to an external web site within an essay question.  When displayed in 
Desire2Learn, the question would look like this: Critique the following website: Click Here  The link will 
open up the Google web site. 

Essay Question with HTML Example 

Type: E 

8. Critique the following website: [HTML] <a href=“http://www.google.com/”>Click Here<a/> [/HTML]

Importing Questions into Respondus 

1. Select Import Questions from the Start tab.
2. Select the file type that you will be importing.
3. Click Browse to search for the file and load it into Respondus.
4. Click Browse to load any image files into Respondus (only if you are using a text file.)
5. If you already have a document open, you can add the questions to the file or you can select to create

a new file.
6. Choose whether you are creating an exam or a survey.
7. Enter a “stem” if you wish to name each question with a chapter or other annotation.
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8. Click the Preview button to preview your questions and determine if they contain the proper
formatting. Ideally, you will see a message in the box that says “No warnings.”

a. If any of your questions do not have answers (or the formatting is incorrect and Respondus
cannot determine the answer), Respondus will automatically assign A as the answer. You will
receive a warning message to this effect.

b. You may receive an error message that numbers were added to the titles. You can ignore this
message. It does not pertain to D2L.

c. You can accept any warnings if they do not affect your test or survey, you can correct the file
and upload again, or continue with the import and correct the questions or answers on the
Edit page.

9. Click Finish to complete the import.

Setting Options 

The settings on this page match the settings in D2L.  Settings chosen will carry over into D2L when the 
assessment is imported.  Those settings existing in D2L but without a Respondus option have been listed 
below.  



Support Contact: Myra Jones (jonesm@etsu.edu; 439-8614) 11 

Properties 
The following D2L settings may NOT be chosen from Respondus: 

Category 

Grade Item 

Auto Export to Grades 

Automatic Grade 

Hints 

Message Description 

Page Header 

Page Footer 

Restrictions 
The following D2L settings may NOT be chosen from Respondus: 

Release Conditions 

Advanced Availability 

Special Access 

Attempts  
The following D2L settings may NOT be chosen from Respondus: 

Advanced Attempt Conditions (appear when choosing more than one attempt, but less than unlimited 
attempts 

Submissions  
The following D2L settings may NOT be chosen from Respondus: 

Show question score and out of score (under Yes – show questions) 

Show attempt score and overall attempt score 

Random Sections 

Random Block settings allow a group of questions to be chosen from a test pool and presented randomly to 
students.  Students in the same class taking the same quiz would be given different sets of questions in their 
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exam.  To add a Random Block of questions: 

1. Select the Random Sections tab and click on the Random Sections button.
2. Select whether to add a new set of random questions or modify an existing set.
3. You must choose a contiguous row of questions to represent the Random Section.  Enter the first

question number in the first box and the last question number to be included in the second box.
4. Select the number of questions to be included in the exam from the chosen Random Section.
5. Select the point value.

6. Click Add New Set to continue adding Random Sections.
7. The letter for the Random Section will be displayed in the left column, indicating that these questions

belong to a Random Section.  Click OK when finished.

Preview and Publish Options 

Preview 
It is recommended that you preview the file before you publish the test to D2L.  If not, you 
should definitely preview the test itself once you have moved it into to D2L. 

Publish Wizard 
1. Choose the Publish tab and then Publish Wizard.  Respondus will walk you through the steps of

publishing your course directly into D2L. 
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2. You can elect to either publish the test to one course section, or you can choose multiple sections if
you will be using the same test in more than one course.

3. Select - add new server - from Desire2Learn server drop-down.
4. Another window will appear, leave the default setting of Yes, and click Next.
5. Here you will enter a name for the server, this can be anything since you will likely only connect to

one server.  Enter your ETSU username and password.  Note:  You can choose to save your
username and password information but this will give anyone with access to your computer the
ability to publish or retrieve tests from your course site. Use this setting with caution!

6. Click Next when you have entered all of your information.  Respondus will check to confirm that it
can make connection with the D2L server.  You should receive a message that the test completed
successfully.  Click Next and then Finish.  Click Next one last time to complete the connection to
the server.  You can skip the step of adding the new server for subsequent uses.  You will have to
update your password when it changes.

Publishing to a Single Course: 

1. Select the drop-down area in the Choose Course field to select the Course where the exam will be
published.

2. You may choose to create a new or replace an existing Quiz, Self Assessment, or Question Library
Section.

3. If you have chosen availability and feedback settings or have designated a Random Section, check the
boxes in section 3.

4. Click Next to continue.
5. Respondus will update the progress as it is publishing and you should receive confirmation that it

was successful.
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OR 

Publishing to Multiple Courses: 

1. Check in the box next to the courses to select the Courses where the exam will be published.
2. Provide a name for the exam to be published.
3. Select how Respondus should handle any duplicates.
4. If you have chosen availability and feedback settings or have designated a Random Section, check the

boxes in section 4. Click Next to continue.
5. Respondus will update the progress as it is publishing and you should receive confirmation that it

was successful.
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Respondus User Guide 

A detailed User Guide is available for download from Respondus 
at:  http://www.respondus.com/products/userguide.shtml 

Respondus does not provide direct technical support to ETSU users. 
Please contact Academic Technology for Assistance. 

Extra Resources 
� Office of eLearning Help Page can be located at: http://www.etsu.edu/d2l 
� Desire2Learn Community website: http://community.desire2learn.com 
� Call the Office of eLearning at: 423-439-8611 
� Contact D2L Help at: d2lhelp@etsu.edu 




